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LESSON 1:

THE BENEFITS OF EXCEL



’ ' Why Use Excel?

e Excel can be an easy way to review significant
amounts of data to identify particular issues or
situations.

e Excel can be used to check calculations
performed within your CAMA system to verify
accuracy.

e Excel spreadsheets allow analytical capability

without requiring your software vendor to
program a specific analysis for you.



’ ' Why Use Excel?

e Excel provides a generally universal method for
sharing data and information with others.

e Excel can be used to prepare custom handouts,
charts, and reports to highlight particular
findings.



' Microsoft EXCEI

e Common versions:
— Excel 2007 (current version)
— Excel 2003 (older version, still popular)
— Excel 2010 (newest version, not very popular)

e While this discussion will focus on Microsoft Excel 2007,
some of the capabilities discussed in this class would
also be present in other spreadsheet packages.
Typically, the Help option can be used to find particular
functionality.



e In Excel 2007, you can open files created in Excel 95
through Excel 2003.

 You can open and edit older workbooks and share files
with people who don’t have Excel 2007.



- Saving Multiple Versions

— When you save a
— . file in Excel 2007,
you can choose
3 from several file
= | = types.

IH
L |

¢ Most Common:
e Excel Workbook (*.xlsx). This is Excel 2007.
e Excel 97-Excel 2003 Workbook (*.xls). Use when you need
to share with someone working in a previous version of
Excel.



% Microsoft Excel Quiz 1

You can open an Excel 2003 Workbook with Excel 2007.

1. True

2. False



» Microsoft Excel Quiz 1

You can open an Excel 2003 Workbook with Excel 20077

Answer:

True

In Excel 2007, you can open files created in Excel 95 through
Excel 2003.
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LESSON 2:

THE BASICS OF EXCEL
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#3%% Terminology

e Spreadsheet — Table used to store and display
data. The table is arranged by rows and
columns.

e Worksheet — Single page or tab within the Excel
workbook.

e Workbook — The entire spreadsheet file.
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Terminology
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e Row — Horizontal array of data.

— Signified by numbers — Row 1, Row 2, etc.
— Maximum number of rows:

e Excel 2003 - 65,536

e Excel 2007 -1,048,576

e Column — Vertical array of data.

— Signified by letters — Column A, Column B, etc.

— Maximum number of columns:
e Excel 2003 — 256
e Excel 2007 — 16,384
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e Cell — Individual cell. Intersection of a row and a
column.

— Signified by a combination of the column letter and
the row number.

e Examples: A1, C300, BA42
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Terminology
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Office Button
Quick Access Toolbar

The Menu

— Home Tab

— Insert Tab

— Page Layout Tab
— Formula Tab

— Data Tab

— View Tab

— Help Tab
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3 Office Button

e New

Recent Documents

1 County Tracking.xlsx

SN
it 2 County Council Review Form - C5 Draft.xlsx 1=l e n

3 County Coundcil Review Form.xlsx

@ e Save/Save As

= = — Can select the type of
<4 file to save

e Print
g s — Print Preview

LT pubiisn > e Recent Documents

i, o= — “Pushpin” feature

| 2] Excel Options [ {3 Exit Excel |
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Quick Access Toolbar

Dn ) ¥
2
Home Insert Page Layout Formulas Cata Review Wiewr
45 From Access Ilﬁ |31 pu. :l_aj Connections al a7z ]?
| .r".l.l"h

4 From Web =1 =1 ; ’ %

e From Other Existing Refresh I L] sort Filter .-

;[ From Text Sources - Connections All = Tl B . Advanced

Get External Data Connection fgdd ko Quick Access Toolbar
Cuskomize Quick Access Toolbar.. .

e The Quick Access Toolbar is above the menu when you first start
Excel 2007. There, commands are always visible and near at hand.

e To add a command to the Quick Access Toolbar, right click on the

command and click “Add to Quick Access Toolbar”. o



The Menu (a.k.a Ribbon)

= : 5 e =X
!_%\ H . _l - Bookl [Compatibility Modg] - Microsoft Excel
- Home | Insert Page layout  Formulas Data Review  View Acrobat @ - P X
iy " — o Hhnsets I -
B & b IR eI S Genenl }J I_;'ﬂ b A? ﬁ
— o i ™ Delete =
Paste |B L0~ i A [EE E|EE| | § - % (|58 8 | Conditional Farmat el |1 . Sorté Find &
S | —|! : ;3 ’ : Formatting = as Table * Styles~ L,JFﬂ”ﬂat' L7 Filter~ Select~
Clipboard & Font i Alignment F] MNumber P Styles Cells Editing
) i ¥
A B C D E F G H I ] K
1 4
W4 b M| Sheetl ' Sheet? - Sheet3 < %] [
Ready

The commands are clearly visible and readily available in
one control center.
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...........

it The Menu (what’s on it)

The three parts

of the menu E% H;]me Insert  Pagelayout  Formulas  Data  Review  View
dare: 5 Calibri oA IE =] (E-3
(1) tabs, F'agtej BIU-[u-0-AllEs=(EgE |s-
(2) grou pS, and Clipboard F Font Ful Alignment ﬁl
(3) commands. - )
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Menu Tabs
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Paste ‘B I U-~ilie|p- A~||EZZE|EE |~ | § ~ Yo% 0 Condtional Format Cell | .. ~ Soté Find &
i = = - = : e Formatting * as Table * Styles > || (ZIFormat ™ | (2™ Filter» Select~
Cliphoard ™ Faont F Alignment F MNumber P Styles Cells Editing
1% v £ I
A B C D E F G H | ]| K L M
1
4 4+ M| Sheet1 /Sheet2 sheets /7], [ I

Ready | ;
The principal commands in Excel are gathered on the

tabs. Tabs represent core tasks you do in Excel. There
are seven tabs across the top of the Excel window.
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Menu Groups

": 93 - Bookl [Compatibility Mode] - Microsaft Excel -8B X
H j =
—/ Home | Insert Page layout  Formulas Data Review  View Acrobat @ - X
e — | = - T Salnset~ | X -
B £ b i AN |[FE=®| & Genenl : ?'ﬂ' i 'jﬂ = Z'i 5‘3
Ep — =l = Delete - || g~
Paste (B I U~ A~|E = Z|EHE G- | $ ~ % o % ;% Conditional Format Cell || ..  Sort& Find &
S § == = gl ’ R Formatting = as Table = Styles~ || (ZIFormat ™ | (2~ Filter~ Select~
Clipboard & Font ] | Alignment 'I Humber [a Styles Cells Editing
K6 v £ | ¥
A B C D E F G H | J K L M N ’
1
M 4+ M| Sheetl  Sheet2 ~ Sheetd -~ ¥J [ m

Ready U@ [Elfi] !% E_!—O —U

Groups pull together all the commands you’re likely to
need for a particular type of task.

Groups are sets of related commands
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Menu Groups continued...

1133 H9-06 )7 Sometimes an arrow,
E Home Insert Page Layout Formulas Data Review View Ca”ed the Dialog BOX
B i Cotior M i S el L B = O i Launcher, appears in
fﬂjte { B £ U -~||#E-|S0-A-|EEE|EEEH-||$ % %6 the Iower—right corner

— ;1 of a group.

Mumber | Aligrment | Font | Border | Rl | Protection This means more

options are available
for the group.

-_A}i 3

Click the Dialog Box Launcher]=], and you’ll see a dialog box or task pane. The picture
shows an example:

1. Onthe Home tab, click the arrow[=] in the Font group.

2. The Format Cells dialog box opens, with superscript and other options related to

fonts.
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Menu Commands

D?ﬁ H _l 5 Bookl [Compatibility Mode] - Microsoft Excel -8X
d) =
-«/ Home | Inset  Pagelayout  Fomulas  Data  Review  View  Acrobat W-0Xx
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S — = = ! e Formatting * 2 Table * Styles~ | (A FOmat™ | (2 Figter~ Select~
Clipboard [ Fant Iy Alignment fi Number fi Styles Celle Editing
K6 v fe ¥
A B C D E ; G H J K L 0 M| N | 0 B
n v T T
Wb N Sheetl - Gheet? - Sheets /%) || i L

Ready

[ERER e ====0"

The
Commands
on the Menu
are the ones
you use the

most.

Instead of showing every command all the time, Excel 2007 shows some
commands only when you may need them, in response to an action you take.

So don’t worry if you don’t see all the commands you need at all times. Take
the first steps, and the commands you need will be at hand.
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Home Tab

-tin. = 2 Bookl - Microsoft Excel -3 X
r.ij :
— Home Insert Page Layout Formulas Data Review View Developer Acrobat ® - 7 X
= & Cut T 2 o= |[= = TP - _I p, - T—‘I:\'J - o ¥ AutoSum * -
Calibri 11 A A== = Wrap Text General 5 e o = : | . [ ¥ &
23 Copy = / s s S S J e ﬂJ 3 it~ ? '
Paste . (B F O~ A== =S|EE A Merge & Certer = ||| % = % | 9 || %3 5%/ Conditional Format Cell Insert Delete Format e Sort & Find &
- J Format Painter o e e St s o >0 Formatting  as Table + Styles * v - - ¢ Clear~ Filter= Select~
Clipboard Pl Fant iF] Alignment ] Number [ Styles Cells Editing
| AL z 3 ¥
A B £ D E F G H J K L M N 0 P a R 5 T
|

e Formatting
e Type of Number
— S, %, Decimal Points
e Conditional Formatting
e Sort and Filter
* Find and Select
e Cut and Paste
e Wrap Text/Merge & Center
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Insert Tab

! f‘_"-:.‘ \ d 8 Bookl - Microsoft Excel -aX
! *ij
—/ Home Insert Page Layout Formulas Data Review View Developer Acrobat (7] = 4
=] | Elg] I_T'J 3 ; JC = ‘i oy Q (A =t ‘q 1 Q
| - e — = 0 = / Fa]
:JJ H || (2] Kb _J’ ‘)-g ih . = SO e || L = 55
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e Tables
e Charts
e Text
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Page Layout Tab

Cin \ Bookl - Microsoft Excel SR
—j Home Insert Page Layout Formulas Data Review View Developer Acrobat (7] = 4
HC-Jl-JI'S =l HT [ Ly = 1 =Y =L | 5} width: | Automatic - || Gridlines | Headings o [ T =
i | ] S e S5 | S0 e U
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Print Area
Print Titles
Margins
Orientation

28



Formulas Tab

Bookl - Microsoft Excel

d9- .

n 1
H
—/ Home Insert Page Layout Formulas Data

Review View Developer Acrobat

3 Trace Precedents 98] Show Farmulas |:j| [ Calcutate Now
=%

@ @ mTﬁ : g -2 Define Name ~ Fd
#7 Use in Formula o3 Trace Dependents ¥ Errar Checking ~ =
Watch || Calculation L:J Calculate Sheet

FZ06®C

Insert AutoSum Recently Financdial Logical Text Dated& Lookup & Math Mare MName . ’ ) 5
Function Usedr - \ +  Time~ Reference ~ &Trig~ Functions~ | Manager EXf Create from Selection || Remove Arrows = (£) Evaluate Formula | Window | Options »
Function Library Defined Names Formula Auditing Calculation

AL v £ | ¥

A B C D E E G H | J K L M N 6} P a R i

— i

e |Insert Function
e Auto Sum



_ = - s Boaokl - Microsoft Excel
F.y :
— Home Insert Page Layout Formulas Data Review View Developer Acrobat ® - 7 X
3 ) = 3 4 5] connedtions | | T3 7 = =m —f A iy E;f'—:j Jr-j oy cm )
AR e : . : 5 &2E = hm i B 5 R S
A0 E DEE BT Br B L BR 0 e _? i I - 2=
Fram From From From Cther Existing Refresh il Sort Filter \( Textto  Remove Data Consolidate What-If Group Ungroup Subtotal
Access Web  Text SourcesT | Connections Allv == Cdit Links .~ Advanced || Columns Duplicates Validation ~ Analysis ~ P 5
Get External Data Cannections Sort & Filter Data Tools Outline ]
Al - fe | ¥
A B C D E F G H | J K L M N 0 P Q 7 5 E
| |

e Sort

o Filter

e Text to Columns

e Remove Duplicates
e Subtotals
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View Tab

Bookl - Microsoft Excel = BEK
Page Layout Formulas Data Review View Developer Acrobat W -0 Xx
IjJ : .J Ruler 7| Formula Bar ':I ’-"': ;El [ Split 11 View Side by Side o
| Gridlines V| Headings \ G 2 4 ______ = Hide 3t Synchranaus Serolling H =
Page Page Break | Custom Full y i Zoom 100% Zoomto Mew Arrange Freeze . Save Switch Macros
layout  Preview Views Screen Wessage oa Selection || Window Al Panes+ | UNNIde | A4 Resel Wingow r Warkspace Windows ~ ™
Warkboaok Views Showy/Hide Zoom Window Macros
| Al - | ¥
A B C D E E G H | ] K IE M N 6} P a R S E
| |

e Workbook Views
e Freeze Panes

e Show/Hide

e /00Mm
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Help Menu
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e Can Search for help or use the Table of Contents

e Another good resource is the Internet
— Example: Go to Google and type in what you are

trying to accomplish
“How to sort in Excel”

— Access various user forums and questions and
answers
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% Microsoft Excel Quiz 2

Quiz 2, Question 1:
An Excel Spreadsheet is the entire Excel file.

1. True

2. False
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% Microsoft Excel Quiz 2

Quiz 2, Question 1:
An Excel Worksheet is the entire spreadsheet file.

Answer:

False

The Excel Worksheet is a single page or tab within the Excel
Workbook. The Excel Workbook is the entire file.
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% Microsoft Excel Quiz 2

Quiz 2, Question 2:
Only one Excel Spreadsheet can be in an Excel Workbook.

1. True

2. False
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2 Microsoft Excel Quiz 2

Quiz 2, Question 2:
Only one Excel Spreadsheet can be in an Excel Workbook.

Answer:

False

You can have many multiple spreadsheets.
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Lesson 3:

Hands-On Exercises
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Sample Data

e In order to complete these hands-on exercises,
vou will need the Excel Excellence.xlsx
downloaded to your computer.

e While we are using this file in our examples, the
functionality discussed could be used with other
files created by you or generated by your CAMA
system.
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Cut, Copy and Paste Special

Cut Effective Depth Column

Insert Effective Depth Column

between Land Lot Type Code and

Actual Frontage

— Right click on Actual Frontage
and click “Insert Cut Cells”

Transpose the column headings to

rows

— Copy Row 1

— Open new Worksheet, click on
Al and go to Paste Special

— Click Transpose and OK

-%/.I Home Insert Page Layout Formulas [rata
‘B ‘E‘ cut Calibri 11 A AT
Paste o o B 7 U ~||&~f- A=
- f Farmat Painter = = = =
Clipboard ] Font F]
T
Paste
v all " all using Source theme
" Formulas " all except borders
" Yalues " Column widths
" Formats " Formulas and number Formats
" Comments " Walues and number Formats
" validation
Cperation
% Mone " Mulkiply
i add " Divide
" Subkract
™ Skip blarks WV franspose.
Faste Link | (04 I Cancel |

o lia A lia lmm i fm fm Lm fom Lo L om L em e
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Helpful Tips - Short Cuts

Some commands can be done in Excel by using a
keyboard shortcut.
Most keyboard short cuts involve the Ctrl Key.

Common short cuts:
— Copy- Ctrl C

— Cut - Ctrl X

— Paste - Ctrl V

— Undo - Ctrl Z

— Save - Ctrl S

— Select All - Ctrl A

— Find - Ctrl F
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Freeze Panes

e Freeze Top Row so column headings are always available
— Ensure column headings are the top row of your spreadsheet
— Goto View Tab
— Select Freeze Panes
— Select Freeze Top Row

= 9 - &)+ Land.xls [Compatibility Made] - Microsoft Excel -8X
- Home Insert Page Layout Formulas Data Review View Acrobat @ - = X
E===3 g , = ™ B || 2 New Windoa B B
£t j L1l Page Break Preview e I'\_: l._‘ | Ca NewWindow [ | 11| O IE:I_“IJ n:|
1G] Custom Views || -~ | Y = oo = Amange Al T |2 m = E=7
(Mormal| Page Show/Hide | Zoom 100% Zeomto |\m—=———"7 _ | . Save Switch Macros
Layout = Full Sereen - Selection |;H Freeze Panes™|_| | 414 | Workspace Windows - -
Workbook Views Zoom e :'_—I Unfreeze Panes ||| Macros
y ' B Unlack all rows and columns to scroll
E5 TN J= | 530410207110000013 - through the entire worksheet, ¥
A B O == Freeze Top Row
1 LAND_ID ASSESSMENT_YEAR | COUNTY_NUMBER PARC :l f;ep thhe ttr?p raﬂstiﬁle wh::ehscrflliﬂq '] LAND_LOT_TYPE_CODE | ACT
2 149254676 2010 53 T e F
3 | 149254677 2010 53 2= Wbkt
. ] Keep the first column visible while scrnII|n| Freeze Top RUW
4 149354678 2010 53 ! through the rest of the worksheet, L



e Insert Column between Base Rate and Appraised Value

— Select Appraised Value column
— Right click to access menu

L T e e L (T L R T LT A U

- SE|eCt |nse rt yrmulas Drata Review View Acrobat

= — — ; General = _:';_g'| Conditional Formatting ~ ;l"ﬂlnsert = F TR
EE= == |% - % | [gFormatasTable~ 3% Delete - || (@]~
E.E £.§| '@" | Tﬁg $B0 | = ol Stilag - '”J' Format = uﬁ v

alignment 1 m| Calibi ~J11 - IA A7 3 - % * JEGE

{ = = . %0 .00 F
E_RATE B I[EH-O-A-wE
J K 1 AA Rl D

EFFECTIVE DEPTH |[BAsE | & Cut _FEET |soiL_ip| st

150 23| copy 9900

332 @ Paste 17424

151 L7424

Paste Special...

132 !D{BE

2 Insert 18295

2 Delete !I}EED

2 Clear Contents L3068

2] : e B3560

5 || Format Ceils... 13550

2 Column Width... E5340

2 Hide 10454
Unhide l "
AﬁErEgE:Zmﬁmrmmmw—mm:@ @l B‘?"}i’{ Lj'
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e Ctrl—F or on Home Tab (Binoculars)

e Find Land ID Number 190117305
—  Press Ctrl-F or press the Find button on the Home Tab
— Type 190117305 in the Find What box
— Select Find Next or hit Enter

| ; General - fﬂ' Conditional Formatting ~ | 5= Insert ~ X - A?' \}a
baf + |||% = % 9 ||| [ Format as Table ~ o Delete ~ j* Z
el i Find &

L} = A A — S':lrt&'.

RN
a1

1§

.'= Find and Replace 7] x| Bt Ty

Editing Iﬁ Eind...

Hac | Replace..

"o

Find I Replace |

Find whak: I ;I | Mo Format Set Farmat... |v| = | GoTo..
] PIL_PRO Go To special...
\Within: ISheet ~| I match case S
[ Match entire cell conkents Comments
Search: |By Rows -
Conditional Formatting
Loak in: IFn:nrmuIas vI Cpkions == |
Constants

Data Walidation
Find All | | Eind Mexk I Close |

Lg | select Objects
21780 21780 1 43560 "EQ Selection Pane...

3]

21780 32670 15 85340 'r|



Replace

Located in same place as Find

Ctrl — F or on Home Tab (Binoculars)

Replace Year 2011 with Year 2012 Select Year column
Press Ctrl-F or press the Find button on the Home Tab
— Type 2011 in the Find What box

— Type 2012 in the Replace With Box

— Select Replace or Replace All

= == General - ;-:__gll Conditional Formatting - | 5= Insert - - Aﬁ;? : ?a
E==- |% - % | [G%FormatasTable- 3 Delete ~ || [g] - Z,
= i . Sort & |Find &
=\ aa| <0 .00 = rall Shelac ~ | Enrmat + 3 Fifter - |Select ~
Find and Replace i Editind 33 | Fina
Find...
Find Replace | 3. Replace..
Find what: I LI | Mo Format Set | Format. .. |-.-| = | GoTa..
OIL_PRO .
Replace with: I | | Mo Faormnat Set | Format. .. |-.-| Go To Special...

Formulas
Within: ISheet vI [ Match case
[ Match entire cell contents Comments
Search: IBv Rows vI

LConditional Formatting

Lok, in: IFu:urmuIas vI Options << | Constants

Data Validation
Replace Al I Replace | Find All I Find Mext I Close I T
g elect Objects

21780 21780 1 43560 LEI';& Selection Pane... 44




Find and Replace —~Workbook

e Find and Replace feature can work within entire Excel
Workbook

e Find Land ID Number 190117305 in Workbook
—  Press Ctrl-F or press the Find button on the Home Tab

- ClICk Opt|0n5 =1 zeneral - fﬁCnnditinnal Formatting =~ g=Inset~ X - A? ja
— Select Workbook af~ | $ - % | G5 Formatas Table - 7 Delete - || [g]~ ?rt& .
L | T S 5} Cell Styles - [EiFomat~ | 2+ Fifter~ select~
from Within box | e ree— 21
— SelectFind Allor o e R
F|nd Next | Find what: | j |N|:| Faormat Set | Farmat.. . |v| r| SOILP
within: [sheet w| I Matrh case

[ Match entire cell contents

Search: Sheet

diforkbook s
Look in: IFDrmuIas vl Opkions =+ |

Find &l Find Mexk Close
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Available on Home Tab and on

Data Tab

Sort by Land Lot Type Code

—  Select full data range

—  Select Custom Sort

—  Select
LAND _LOT_TYPE_CODE in
the Sort by dropdown box

Multi level sorts can also be done

in Excel

—  Click on Add Level

— Select LOT_NUMBER from
the dropdown box

—  Click OK

e Layout

ns

A
F
F
A

Formulas Data

l Sort | Filter

Review

=]
+

EEE)

Textto  Remove
'_’,?—Ldvanced Columns Duphcates £ ) What-If Analysis =

View

Acrobat
= = =Y Data Validation ~
Ln Consolidate

% Group ~ =

+# Ungroup *

3 subtotal
21

J;[ Add Level >( Delete Level =2 Copy Level Options.., [¥ My data has headers
Column Sort On
Sort by v| |'|,|'a||_|es vl AtoZ v

LAND_ID
ASSESSMENT _YEAR
COUNTY_MUMEER.
PARCEL_ID
PARCEL _NUMBER
LOT MUMBER.

ACTUAL_FRONTAGE
EFFECTIVE_FRONTAGE
EFFECTIVE_DEPTH
BASE RATE

oK Cancel

o
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Available on Home Tab and on

Data Tab in same place as Sort

Filter for Land Tot Type Code 91

— Select Row 1

— Go to Sort & Filter on Home
Tab or to Filter on Data Tab

— Select Filter

— Go to drop down arrow on
Land Lot Type Code

— Uncheck all Land Lot Type
Codes other than 91

— Hit OK

d9-a ) Land.xs [¢

Home Insert Page Layout Formulas Data
|Za] Connections | 4 | Bo = Clea
4 £ Al
2] S| 24 212 \
il Refresh - Z] Sort Filter | .,
A~ == Edit Links A«lr _T!‘:?Ad'l.ra
Connections Sort & Filter
H4 - &0
E F e

CEL_NUMBEF ~ | LOT_NUMB ~ | LAND_LOT_TYPE_COL ~ | A

02071 4| sortAtoz

:gzgi Zl| sortZto A -

02071 sort by Color >

oDzoso| &

02080 h

02080 Text Filters >

02090

02100 -] (Select All)

02100 ~[]1

02110 g ‘; -
Land

_Land =
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e Available on Home Tab and on Data Tab in same
place as Sort and Filter

e Clear filter from Land Lot Type Code column

1. Go back to drop down box on top row of Land Lot

Type Code
a) Select All
b) Clear Filter

2. On Home Tab and Data Tab, option available for
Clear
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3 Helpful Tips — Multiple Rows

e Edit more than one cell, row or column at a time by
using the Ctrl Key

e Add commas to Appraised Value and Square Feet
— Highlight Appraised Value
— Hold down the Ctrl Key and highlight Square
Feet

— Change columns to include commas
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) Helpful Tips — Table or Array

e Select an array of data or an entire table of data by
using the Shift Key

e Select all data in the Land File Worksheet
— Select Cell A2
— Scroll to end of data, Cell Y250
— Select Cell Y250 while holding down the Shift
Key
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: i Helpful Tips - Worksheets

e Edit more than one Worksheet at a time by using
the Ctrl Key

e Change Column B in the Land File and in the Chart

Data Worksheet to a yellow fill
— Highlight Column B in the Land File
— Hold down Ctrl Key and highlight the Chart Data

Worksheet tab
— Keep Ctrl Key down and fill Column B
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b, Conditional Formatting

e Available on Home Tab

e Next few screens walk through pre-defined
options

e You can also get more specific through New Rule
or Manage Rule options
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Conditional Formatting

11T =y 2 Autos
e == [
= B =il Greater Than...
_onditional | F t Cell Insert: Belete F t :
Formatting |as Table - styies~ |+ -« | <2aar o Less Than...
- _—'EJ Highlight Cells Rules * __Iﬂl Greater Than... = () BEtween...
8 _ﬂul Top/Bottom Rules  # _Iﬂ] Less Than... LT ¢ Equal TO"'
| = = B o TeXt that
E Data Bars g ﬂ Between... .
] | Contains...
E Color Scales g =L Equal To... .
== e A Date Occurring...
_i Icon Sets k —_Igt! Text that Contains... _ () Duplicate Values."
| e R —% A Date Occurring...
_-_'__',.- Clear Rules po| T
i5d| Manage Ruies.. 7y é Duplicate Values...
72 Mare Fules...
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Conditional Formatting

: —_— T Au
5y sl o Top 10 ltems...
[
_onditi Bl F t Cell I i Belete F i -
Formatting ~las Table - styies= |+ + v | <2a o Top 10%...
T i_ells
= 2], maniiant cens Rutes > L e Bottom 10 Items...
= 0
5 _ﬂl{l Top/Bottom Rules  » iLll Top 10 Items... E ¢ BOttom 10/0"'
fi= = o Above Average...
E Data Bars g —ﬂ Top 10 %e...
_ e Below Average...
E Color Scales 4 _.Jﬁ Bottom 10 Items...
::E Icon Sets b ___4% Bottom 10 %...
b | New Rule.. i:U Above Average...
_"_'_l,',a Clear Rules k B E]
{5] Manage Rules... i _._JE i A
72 Mare Rules..,
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%8 Conditional Formatting

e Highlight Duplicate Values T (e o w—
T g g p 15:5 fiﬁ :jd ;"Delete' Ev ‘%? L:?
in the Land ID Column Fondtions romat  Cel || iromat~ || @+ Sort P
— Select the Land ID Column | sovsmcannis s | =] oemn. |

— Go to Conditional | Ay ropmotommues | [l e han.
Formatting B oota sas | B petween.

— Select Highlight Cell Rules | B corsaes | =] sovarre.

— Select Duplicate Values... | fijwmse 2] sommconsmn. |

— Can customize format of = wevee. -
the rule = [—— _

=1 Duplicate Values...

- H |t O K More Rules...
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; Conditional Formatting

Conditional

Formatting =/ as Table = Styles = L;_]Fnrmat' (2™ Filter~ Select~ F 1
Cells Editing Ormattl ng

W oo Egr @y e Toclear Conditional

Format Cell e Sort & Find &

3 —_'l Highlight Cells Rules ¥ e

5l — Go to Conditional
N 0 P
| _rﬂunl Top/Bottom Rules  + |y cpeage | suare_FeeT [soiL_ip| soiL Formattin g
] | 02273 9900

E| oasas  |os e — Select Clear Rules

=P R B — Select Clear Rules from

. m— Selected Cells or Clear
| [i=| lonSets v | B O pseseni=) [ .

— Rules from Entire Sheet
“} Clear Rules b Clear Rules from Selected Cells as applicable

(4] Manage Rules.., Clear Rules from Entire Sheet
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Remove Duplicates

e |ocated on Data Tab
e Remove Duplicate

Records

— Select full data range

— Select Remove
Duplicates

— Select which columns

contain duplicates

e To ensure the full
record is an exact
duplicate, Select All
columns

— Hit OK

Data

Review View Acrobat

E * E mm =4 Data Validation ~ | 3 Gro
= @

Text to Eemowe

LF' Consolidate ~ Ungroup =

up -

27 Advanced || rolumns Duplicates =P What-If Analysis = || Eff| Subtotal

ter

53_
53
53
53,
53|
53
53
53,
53|
53

Diata Tools Cutline

Remove Duplicates 8

To delete duplicate values, select one or more columns that contain

IER I duplicates,

2

:j = Select Al 5= Unselect Al | IV My data has

headers

| Columns

v
W
v
v
v
v
v
v

v

v

AAAAXAIAAA

LAND_ID
ASSESSMENT _YEAR
COUNTY_NUMEER.
PARCEL_ID
PARCEL_NUMBER
LOT_MUMBER
LAND_LOT_TYPE_CODE
ACTUAL_FRONTAGE
EFFECTIVE_FROMNTAGE
EFFECTIVE_DEPTH
BASE_RATE

QK

Cancel |

I
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SR8 Functions

e Excel has a large number of built-in functions.
e To use these pre-defined functions, you need to be

cognizant of the specifics of the function:

— What is the function designed to do

— What cells need to be included in the calculation

— What criteria must you specify for the calculation

— In what order are these cells or criteria required to be

entered
e Formula Dictionary on Formulas Tab
— Insert Function
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%) Simple Cell Mathematics

Mathematical formulas can be performed in Excel that do

not require a pre existing function.

— Variety of different mathematical functions: addition (+), subtraction
(-), multiplication (*), and division (/)

For example, add Cells E2 and E4
Type =

— Click/type Cell E2

— Type +

— Click/type Cell E4

- =E2+E4

Constant values, instead of a cell reference, can also be used

For example, multiply E2 by 55%

Type =
— Click/type Cell E2
— Type *0.55
— =E2*0.55
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Functions

Common Functions

SUM — Adds together selected values

AVERAGE — Calculates the average of selected values
MAX — Identifies the maximum value in selected
range

MIN — Identifies the minimum value in selected
range

ROUND - Rounds numbers to a particular decimal
point precision

COUNT — Counts number of values in selected range
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Functions — SUM & AVERAGE

Sum Appraised Value for all records

— Go to bottom of the Appraised Value column
— Incell below data, type =SUM(

— Specify range to be included in calculation

—  Close formula with an end parenthesis

— Hit Enter

—  =SUM(L2:L250)

Determine Average of Square Footage

— Go to bottom of the Square Footage column
— Incell below data, type =AVERAGE(

—  Specify range to be included in calculation

—  Close formula with an end parenthesis

— Hit Enter

—  =AVERAGE(N2:N250)
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Functions — MAX & MIN

ldentify Maximum Value for Acreage

— Go to bottom of the Acreage column

— Incell below data, type =MAX(

— Specify range to be included in calculation
—  Close formula with an end parenthesis

— Hit Enter

—  =MAX(M2:M250)

ldentify Minimum Value for Base Rate

— Go to bottom of the Base Rate column

— Incell below data, type =MIN(

—  Specify range to be included in calculation
—  Close formula with an end parenthesis

— Hit Enter

—  =MIN(K2:K250)
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; ) Functions - ROUNDING

e ROUND

Go to cell right below average calculation
Type =ROUND(

Select cell to be rounded

Insert a comma

Identify decimal point precision
e 0O=nodecimals

e 2=twodecimals

e -2 =round to nearest 100

Close formula with an end parenthesis
Hit Enter
=ROUND(N204,0)
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3 Functions - COUNT

Count the number of records with a Soil

Productivity Factor

— Go to bottom of the Soil Productivity column
— In cell below data, type =COUNT(

— Specify range to be included in calculation

— Close formula with an end parenthesis

— Hit Enter

— =COUNT(P2:P250)
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2 Text To Columns

Located on Data Tab
Excel is able to divide values from one cell using the Text

to Columns function.
—  Excel can divide a cell based on two general features
e Fixed Width
e Delimited with a specific character (spaces, commas,
semicolons)

Go to Text to Columns Worksheet
— Highlight Column A

— Click on the Text to Columns Command
— Click Delimited option

— Click Comma

— Click OK
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® Combine Values from Two Cells

We can combine values using the following formula in

another cell.
e Excelis able to combine values in cells

e For example:
— |f we have two columns, one with first name and another with
last name.
e Example: We have the first name in Cell A1 and last name in B1
e We want first then last with a space in between, then the

following formula combines the two.
- =A1&"” “&B1
e Or, if we want last name then first name with a comma

between, the following formula works.
- =Al1&”, “&B1
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' Charts

e Excel provides a wide range of charting options on
the Insert Tab.

— Column Charts

— Pie Charts
— Bar Charts
— Line Charts
nulas Data Review View Developer AL
. - M e 8D
Column Line Area Scatter Other
- - - - L. - Chan51

- & F.
khaﬂa 67




e Design a Column Chart

showing Acreage by Land

Lot Type

Go to “Chart Data”
worksheet

Go to Insert tab
Highlight the chart data
and Select Column

2-D Column

Jid

[

3} Charts — Column Chart

5

Clmn

Lin

Data Review View

ﬂLD

Acrobat

Area Scatter Other

2-D Colu

mm%

3-D Column

5 a3 93

di

Cylinder

) |a8] /98]
L] o8] JAA] X

Pyramid

JJU Jﬁi J&i )

il 2N chart Types...

L Charts ~
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Charts — Column Chart

Appraised Value By Land Lot Type

2,621,680

352,280
17,500 3,210 12200 0 12,470 33,480 . 61,870 47,800 7,520

1 4 5 6 9 21 41 42 72 91 F

e (Can use Design, Layout and Format menus specific to the
Chart to change how the Chart is presented

— Add Appraised Value totals to top of columns
e Update chart title in chart directly
— Appraised Value by Land Lot Type



Saving Workbook

e Save the Excel Workbook as an Excel 97 — Excel 2003
Workbook.
— Click on the Office Button
—  Click Save As
— Direct where the file should be saved
— Select Excel 97 — Excel 2003 Workbook from the Save as
type dropdown box
— Namefile
—  Click Save

]
Filz name: ILand.xIs

L]

Save a5 BYPE: |py ol 97-2003 Workbaok (*.s)

Excel Workbook (*,xlsx)

Excel Macro-Enabled Warkbook (*,xlsm)
Exxcel Binary 'Workbook (*, xlsh
Excel 97-2003 Workbook (* xls)
#ML Data (*,ml)

Single File Web Page (*.mht; *, mhkml) v

| w4
1
[uT]
=3
[}
o
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e Before printing

— Determine the purpose for your printing and try to
arrange your data so you get the exact printout you
need.

— Print preview before printing to ensure the final
printout will be useable.
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29 Printing — Preview and Titles

e Print Preview

Customize size and layout of paper
Center on page

Add headers and footers

e Title of worksheet

e Page numbers

e Prepared by

e Any disclaimers or notes

e Page Layout Menu — Print Titles

Customize column or row headings to be repeated on
each page during printing.
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2 Microsoft Excel Quiz 3

Quiz 3, Question 1:

A column can only be inserted by using the command on the
Home tab.

1. True

2. False
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&8 Microsoft Excel Quiz 3

Quiz 3, Question 1:

A column can only be inserted by using the command on the
Home tab.

Answer:

False

You can use the command or you can right click on the column
right of where you want the new column to be.
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2 Microsoft Excel Quiz 3

Quiz 3, Question 2:

Multiple columns can be filtered at one time in an Excel
Spreadsheet.

1. True

2. False
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% Microsoft Excel Quiz 3

Quiz 3, Question 2:

Multiple columns can be filtered at a time in an Excel
Spreadsheet.

True

As long as there is only one table of data in the spreadsheet,
then multiple columns can be filtered at the same time (only 1

row of data in a spreadsheet can have the filter). I



% Microsoft Excel Quiz 3

Quiz 3, Question 3:

What do you type into an empty cell to start a formula? (Pick
one answer.)

s



: ; Microsoft Excel Quiz 3

Quiz 3, Question 3:

What do you type into an empty cell to start a formula? (Pick
one answer.)

Answer:

An equal sign (=) tells Excel that a calculation follows it.
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Microsoft Excel Quiz 3

Quiz 3, Question 4:

What is the correct formula to round 29,128.6547 to the
nearest hundred?

A. =ROUND(29,128.6547)
B. =ROUND(29,128.6547, 2)

C. =ROUND(29,128.6547, -2)
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i) Microsoft Excel Quiz 3

Quiz 3, Question 4:

What is the correct formula to round 29,128.6547 to the
nearest hundred?

Answer:

C. =ROUND(29,128.6547, -2)

Formula (B.) would round to the nearest hundredth.
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% Microsoft Excel Quiz 3

Quiz 3, Question 5:
Which short cut is used to Select All?
A. CtrlZ

B. CtrlA

C. CtrlS
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3% Microsoft Excel Quiz 3

Quiz 3, Question 5:
Which short cut is used to Select All?

Answer:

B. Ctrl A
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Lesson 4:

Import a Text File
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Import Text File Into Excel

Open a blank Excel spreadsheet. Click the Office
Button.

Click on OPEN (or use the icon button)

Navigate to where you saved the .txt file and open

it.
Highlight the filename you want to open and click

OPEN.

A TEXT IMPORT WIZARD box will open prompting
you to select how you want the data to appear
when viewed using Excel.
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Import Text File Into Excel

The Wizard allows you to
choose column formats,
provides data preview, and

other advanced settings.

—  Click on Fixed Width

—  Start import at Row 2, click
Next

— Using the file specifications in
50 IAC 26, move break lines to
desired positions, when done
click Next

— Click General for data format

Click on Finish.

Text Import Wizard - Step 1 of 3 K E3
The Text Wizard has dektermined that wour daka is Fixed Width,
IF this is correct, choose Mext, or choose the data bvpe that best describes vour data.
riginal data type
Choose the File bvpe that best describes vour data:
€ Delimited - Characters such as commas or tabs separate each field.
¥ Fixed width - Fields are aligned in columns with spaces between each Field.
Skart impork at row: |2 E‘ File origin: I 437 | QOEM Uniked States LI
Preview of File WiotFilpSOpw.shared. state in, us\DLGFY HOME MModermot b\ Excel Presen. . \OILGAS. bxt.
1 [FILEMAME: OILGAS County Number: l4County Description: DAVIESS o
z jhos7513000 OTLJIOHN DAVIS Operator O0000000000000L
S PO077EEZ000 OILW NOWLING Oumier 000Z0000000000
4 o077 E00000 OILA. EHILLION Ounae r 000Z0000000000
5 jpos7Elz000 OILCOREIN Owmaer 00012000000001) -
il >
Cancel I = Back Finish I

Text Import Wizard - Step 3 of 3

This screen lets you select each column and set the Daka Format,

—Column data Format————

‘General converts numeric values ko numbers, date values to dates, and all

remaining walues to text.
Advanced. .. |

© Text
" Date:  |MDv -

Do not import calumn (skip)

Daka preview

encral eneral Geperal

County Number: l4County Descrifption: DRVIESS =

OILJOHN DAVIS Dperator 0000000000000 1E1

OILW MNOWLING Duner 0O00Z000000000000

OILA. KILLION Dumer 0O00Z000000000000
OILCOREIN Dumer 0001l500000000111 vI

B

Cancel < Back [ext = I Finish I
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MY Contact the Department

Eric Bussis — Director
e Telephone: 317.232.3759
 E-mail: erbussis@dlgf.in.gov

Megan McDermott — Asst. Director
e Telephone: 317.232.8347
e E-mail: mmcdermott@dIfg.in.gov

Data Division General Mailbox: data@dlgf.in.gov

Web site: www.in.gov/dlgf
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